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Description

ePress creates standalone electronic business cards (eCards) which can be distributed on conventional 
media or over networks to facilitate exchange of personal information.

Typical use of an eCard would be to send it as an attachment to an e-mail message to provide the 
receiver with more than the usual text-only signature.

New features

The major improvements over the previous version are: long, multistyled, aligned and colored text; 
support for standard pictures and Finder icons as well as the old ‘cicn’ resources; background patterns 
and customizable interface colors; a new plugin architecture; online documentation; improved 
interface; improved Clipboard support; PowerPC native code.

Requirements

ePress requires System 7.1 and the Thread Manager to run. The Thread Manager is a multithreading 
enabler built into System 7.5 (or later versions), and can be installed in previous systems in the form of
a system extension (distributed free from Apple). ePress is compatible and runs native on Power 
Macintosh computers.�

eCards do not require any particular extension to System 7 in order to run.

Freeware notice

ePress is available free to the public. However postcards, junk material and spontaneous donations will
encourage further development and improvement of this program.

Distribution

Associations, Magazines and Bullettin Boards planning to distribute/review this software are kindly 
requested to send me a copy of the media/magazine on which the program is being 
distributed/reviewed, or an e-mail notice at least. Please don’t distribute modified versions without 
explicit permission.

Author

I’m a student at the Department of Computer Science, University of Pisa. My primary occupation 
should be the plenty of non computer-related courses at my college, but my real commitment is 
programming the Macintosh and I’m waiting to get ‘an haircut and a real job’ in some more interesting 
enviroment.�

Comments, suggestions, bug reports and donations can be sent to my postal address:



Gabriele de Simone

via Trento, 3

56100 Pisa

Italy

Internet citizens can take advantage of my electronic presence for a faster response (please let me 
know if you wish to receive new versions by e-mail):

<mailto: macman@finsystem.it>

<mailto: desimon@cli.di.unipi.it>

<mailto: gabriele@nsm.it>

<http://www.cli.di.unipi.it/~desimon/intro.html>

People living in my country can easily reach me on PAN (0575/24676), an Italian Macintosh bullettin 
board I often connect to. Informations on this service are also available on the web site 
<http://www.pan.it/>. Its administrators and founders are friends Mario Ghezzi and Francesco Fumelli.

I occasionally write reviews for an Italian Macintosh magazine. Have a look at their site if you 
understand Italian: ‘M’ Macintosh Magazine, <http://www.mix.it/macmag>.

NSM is a web content provider <http://www.nsm.it/>. I represent the one and only Macintosh user 
inside it and I will be thankful if you drop them a note about our platform’s superiority.

Aknowledgements

Many thanks to all the beta testers and localizers who helped me with this project and to the dearest 
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the-dark boxers from the GeekWare collection.

The plug-in architecture



The new plug-in architecture built into ePress accepts three types of documents which can extend the 
application’s functionality (but not modify its interface or behaviour). Localization and Code plug-ins 
actually contain the data ePress uses to create eCard applications. Snapshot plug-ins are libraries of 
graphic elements you can install in your eCards (snapshots, background patterns and interface 
palettes).

• Localization plug-ins contain the language-dependent interface elements of an eCard (menus).

• Code plug-ins contain object code and application resources of an eCard.

• Snapshot plug-ins contain any or all of picture, Finder icons, color icon, pattern and palette type 
resources (‘PICT’, ‘ICN#’, ‘icl8’, ‘icl4’, ‘cicn’, ‘ppat’, ‘clut’).

Any file can be changed to a plug-in by simply setting its type and creator to reflect the desired kind of 
plug-in (it has to contain compatible resources to be used, though). For a plug-in to be recognized on 
application launch, it must be located anywhere within the ePress folder.

Plug-ins availability

Additional plug-ins are available since ePress introduction. These ‘kits’ were not included into the 
original package since downloading only the needed/wanted parts was faster for most users. The 
following is a list of most requested plug-ins:

• ePress European Kit (localization for most Western languages)

• ePress Japanese Kit (localization and code to create Japanese eCards)

• ePress Simpsons Kit (hand-drawn snapshots featuring Simpsons characters)
 
Cross platform distribution

One major drawback of eCards is their inability to run on other platforms. Keep this in mind when 
sending your eCard over networks: only Macintosh destinataries will be able to view its content.

Also, when sending your eCard as an attachment to your Internet mail, make sure that the eCard is 
compressed and encoded before being attached to your message. Mail programs usually support 
automatic encoding of a message attachments. Some even provide automatic compression.

Cross platform implementation of eCard though the Java language is being considered for future 
versions.

Importing graphic formats other than PICT

If QuickTime 2.5 and Macintosh Easy Open happen to be installed in your system folder ePress will let 
you import (via the ‘Insert > picture file...’ menu command under the ‘File’ menu) other popular 
graphic formats such as GIF and JPEG. The conversion to the PICT format is done transparently and 
automatically for you by QuickTime 2.5. The rules on the maximum width and height of importable 
pictures also apply to these converted files.

QuickTime-compressed pictures

ePress lets you import and paste QuickTime images into eCards, for the fact that QuickTime 
compressed PICTs are treated equally to conventional PICT data. Though compressed images are 
smaller to distribute than their uncompressed equivalent, remember that the receiver will be able to 



view these images only if QuickTime is installed on his/her machine.

Though QuickTime is very likely to be installed everywhere in these days of multimedia, using 
uncompressed images is an easy workaround. Uncompressed images also load faster than compressed
ones on eCard launch.

Invisible Snapshots

There are some rare cases when a snapshot is not viewed when the eCard is opened. If the snapshot 
you install in the eCard is complex (such as for a 24-bit image) the default application memory 
partition may be insufficient to view the snapshot. Simply increase the eCard application memory (in 
the Finder ‘Get Info’ window) to view your image correctly.

Fonts conflicts

One of the great improvements over the previous versions is support for styled text. However, before 
browsing your huge personal collection of fonts looking for the right candidate to use in your eCard, 
keep in mind that the receiver will view your eCard correctly only if the fonts you use are also installed 
on his Macintosh.

Times and Helvetica, for example, are very likely to be found on every Macintosh on earth; other fancy 
fonts, while great looking, may produce unpredictable results when viewed on a Macintosh where that 
particular font family is not available.

Background patterns explained

The type of resource ePress uses to draw background patterns is ‘ppat’. This format is also used by 
Apple’s Desktop Patterns control panel. However, when you copy a pattern from Desktop Patterns, a 
picture, not a ‘ppat’ resource, is copied into the clipboard. If you later paste that pattern in ePress, the 
picture is - as you should already now - imported as a PICT-type snapshot.

To successfully paste patterns you need to copy them with a resource editor (like ResEdit) or create 
‘ppat’ resources yourself (again, with a resource editor or some other pattern utility).

Interface palettes explained

Beginning with version 4.0.2, you can customize the colors in eCards’ interface by installing a ‘clut’ 
type resource. ePress (and eCards) uses any ‘clut’ resource which contains at least 9 colors and 
ignores all colors in the table whose index is higher than 9. The first seven colors are used for all 
interface elements except text contained in text fields. The last two colors in the ‘clut’ palette (indexes 
8 and 9) are used as the text back and fore colors. As for the current version, the text fore color is 
practically ignored and its value substituted by the color(s) you apply in the ePress editing window. The
text fore color has been solely provided for future versions which might need that value for other 
interface elements.

The ‘Personal Info’ menu commands

As with previous ePress versions, it is possible for the user to save all textual information and some 
customization settings into a private ‘Personal Info’ record. This way, it is possible to avoid re-entering 
all your personal information each time you have to make your own eCard.

It is also possible (via the option in the ‘Preferences’ window), to paste these information every time 
the ‘New...’ command is chosen from the ‘File’ menu (making it the default information from which to 
start building a new eCard).

To store these ‘Personal Info’, choose the ‘Copy to Personal Info’ command (under the ‘Edit’ menu) 
whenever a new or existing eCard is being edited. Similarly, choose ‘Paste Personal Info’ to fill out the 



current eCard with the ‘Personal Info’ (if you saved any). The previous content of the eCard is replaced 
by the new text.

How to add pictures in the text fields

TextEdit, which is the system software text engine ePress uses, does not support embedded pictures. It
is possible to overcome this limitation with a trick: there’s an application called ‘FC Text-Picture’ (© 
Ammon Skidmore) which converts a variety of image and icon formats to a styled text file (or to the 
clipboard, for instance). This styled text data can be easily pasted into ePress.

This tecnique can produce amazing results, but must be used wisely. Due to the technique used to 
store image data into styled text, the results can show very slowly even on middle-range machines.

Keyboard Shortcuts

• Holding down the Option key and pressing the left and right arrows in the eCard editing window lets 
you view the previous/next snapshot in the current plug-in.

• Holding down the Control key and pressing the left and right arrows in the eCard editing window lets 
you view the previous/next pattern in the current plug-in.

• When the Credits in the about window are scrolling, the up and down arrows control the scrolling 
speed.

Version history

ePress

4.0b3 - Public beta release.

4.0.0 - Final release.

4.0.1 - Improved reliability. Some minor interface changes. Drawing operations and interface 
responsiveness can be significantly faster on most machines. The clipboard now supports ‘ppat’ and 
‘cicn’ resources properly. ePress doesn’t attempt any longer to import pictures and icons whose 
dimension is larger than eCards’ boundaries.

4.0.2 - Added support in plug-ins and eCards for another resource type: ‘clut’ (Color Lookup Table). This
version of ePress is backward compatible with existing 4.0.x eCards.

4.0.3 - Fixed a bug associated with the scroll bar in the eCard editing window. Improvements in 
interface performance and functionality.

eCard

4.0b6 - Public beta release.

4.0.0 - Final release

4.0.1 - The eCard code has been largely modified. 



4.0.2 - Support for ‘clut’ (Color Lookup Table) resources describing interface colors was added.

4.0.3 - Minor changes to the code.

Future improvements

Below are some of the improvements I plan to include in future releases:

• adoption of the WASTE text engine instead of TextEdit. WASTE most desirable features include 
clickable URLs (now available only on some configurations) and Drag&Drop editing;

• integration with the Internet Config component to ease data entry;


